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What's New
What's New in Tl Connect™ CE Software v5.4.0

Quit Exam Mode Setting on Connected CE Calculators

Quit the exam mode setting on your CE by connecting CE calculator(s) to the computer
and selecting

e Actions > Quit Exam Mode on Connected CE Calculators in TI Connect™ CE.

Reminder: Use the latest CE Bundle at education.ti.com/84ceupdate to ensure your CE
has the latest and appropriate calculator files for your TI-84 Plus CE.

For more information about the new and updated functionality, go to
education.ti.com/84ceupdate.
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Introduction to the Tl Connect™ CE Software

The Tl Connect™ CE software makes exchanging information between your graphing
calculator and your computer quick and easy.

Supports any TI-8x graphing calculator with a USB port, which include:

e TI-84 Plus CE

e TI-84 Plus CE-T

e TI 84 Plus CSilver Edition

e TI-84 Plus

e TI-84PlusT

e TI-83 Premium CE Edition Python & TI-83 Premium CE
e TI-83 Plus.fr

e TI-82 Advanced

*Note: The TI-83 Premium CE Edition Python and TI-83 Premium CE will both display as
TI-83 Premium CE.

Note: Use TI Connect™ CE 4.0 which supports calculators with an 1/O port only:
e TI-83 Plus

e TI-89 Titanium

e Voyage™ 200

e TI-73 Explorer™

2 Introduction to the Tl Connect™ CE Software



Using the Tl Connect™ CE Software

The TI Connect™ CE software contains tools you can use to exchange information
between your calculator and your computer.

File  Edit  View  Actions  Help

=

CONNECTED CALCULATORS (1)

(5] @ T84 Plus CE

Press [8] to capture calculator screens

The Tl Connect™ CE software includes three workspaces:

e Screen Capture: allows you to manage screen captures
e Calculator Explorer: allows you to manage calculator content

e Program Editor: allows you to manage Tl Basic programs

Using the Tl Connect™ CE Software
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Parts of the Tl Connect™ CE Software
_lo|x]

File  Edit  View  Actions  Help

B ce [

CONNECTED CALCULATORS (1)

(5] % T84 Plus CE

0553

Press [8] to capture calculator screens

(3] (4] 5 (5]

o Menu Bar - Use these menus to manage calculator files and screens to view
calculator information, and to get help.

File Edit View Actions Help

Toolbar - Use these icons to manage computer files and screens.

=R ] [ 100%

@ Workspace Panel- Use this panel to select workspaces (Screen Capture,
Calculator Explorer, and Program Editor).

)

IE]

e Calculator List Panel - Use this list to view all connected calculators and to
select one calculator for display.

4 Using the Tl Connect™ CE Software



CONNECTED CALCULATORS (1) (O]

% T1-84 Plus CE i

@ Content Panel - Use this panel to view and manage the calculator files and
screen on connected calculator(s).

& TI Connect™ CE

File  Edit  View  Actions  Help

-o] x|

B 8 8 1 &

CONNECTED CALCULATORS (1)

(5] % TI-84 Plus CE

Note: You can complete most of the actions in these menus by dragging and
dropping items to your connected calculator or computer.
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Using the Screen Capture Workspace

The Screen Capture workspace allows you to manage calculator screen captures.

& 11 Conneat™ CE o x|
File Edit View S
B ®
*Capture 1 x
(5  CONNECTED CALCULATORS(1)
NORMAL FLOAT AUTO REAL RADIAN HP
\E @ TI-84 Plus CE ¥1z¥2-3
]
. 01 -2.99
s 02 -2.96
03 -2.91
on -2.84
05 -2.78
06 -2.64
o7 -2.51
08 -2.36
03 -2.19
1 -z

*Capture 2 X

NORMAL FLOAT AUTO REAL RADIAN MP n

tvalue
:zero
minimum

rintersect
tdusdx

1
2
3
4:maximum
S
6
7:f(x)dx
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Parts of the Screen Capture Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to save, send, copy, delete, and resize files.

Save a file to the computer.

Send a file to a calculator.

Copy a file.

Delete a file.

Add or remove a border from all captured screens.

Change the size of all captured screens.

(N o Nol~ o TN

View the screen capture size.

Content Panel - View screen captures in the Content Panel.

*Capture 1 x

1]

NORHAL

FLOAT AUTO REAL RADIAN HP

Capturing and Using Screens

In the Screen Capture workspace, you can capture and view screens from your
calculator.

Using the Screen Capture Workspace



Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

To Capture Calculator Screens

1. On the Tl Connect™ CE software Workspace Panel, click the Screen Capture
workspace.

2. Display the screen on your calculator that you want to capture.
3. Click next to the desired calculator in the Calculator List Panel.

e If more than one calculator is connected, click on next to CONNECTED
CALCULATORS to capture screens from all calculators.

Saving Calculator Screens as Files

The Screen Capture workspace lets you save captured or existing images from your
calculator as a PNG.

*Capture 1 x

1]

NORMAL

FLOAT AUTO REAL RADIAN HP

Note: The asterisk at the beginning of an image name indicates that the image is not
saved.

To save an existing screen

1. Click the captured screen in the Content Panel.

2. CIick.

To save multiple screens
1. Click Edit > Select All.

2. CIick.

To rename a screen capture

1. Place your cursor at the beginning of the screen name field.
Ex: Capture 1.

2. Double-click the name to select it.

3. Type in a new name for the computer file.

8 Using the Screen Capture Workspace



To save a new screen capture as a PNG file

1.

5.

Click the image.

Click .

Navigate to a desired save location.

Use the default file name or type a new file name.

.
Click .

To send screen captures to connected calculators

This Screen Capture only feature provides a way to take a screen capture of a graph on
the high resolution calculators, crop to the graph area and then convert only the graph
area to a Background Image. Check Graph Area Only to create this type of Background

Image.
1. If you have not already done so, capture the screen.
2. Click the screen capture to select it.

b

& send to Calculators x|

FILE NAME: NAME ON CALCULATOR: LOCATION: I

Capture 2 Image1 v \/

Screen captures and converted image files will be sent as Pic Vars to black and
white calculators

DESTINATION CALCULATORS: [J Graph Area Only

(®) All Connected Calculators () select Calculators

[[] Replace existing content with the same name on destination calculators

CANCEL SEND

FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the screen capture on your computer.

NAME ON CALCULATOR: select the background image (it should be the default, but
you may change the background image name using this menu).

Note: Screen captures and converted image files will be sent as Pic Vars to gray
scale calculators.

GRAPH AREA ONLY: In the right panel, select whether you want to send just the
graph area, or the entire screen. When sending a screen capture back to a
calculator, it is best to send the graph area only.

Cropping an Image

Using the Screen Capture Workspace 9



A screen capture of the graph area includes the full screen of the TI-84 Plus CE,
status bar, graph border, and the graph area.

Tl Connect™ CE software allows you to crop the image to a Graph Area Only size to
create a Background Image Var. You can crop a screen to Graph Area only in the
Send to in the Send to Calculators dialog box.

W77

LT

.| Graph Area Only | Graph Area Only
e DESTINATION CALCULATORS: Select whether you want to send the image to all
connected calculators, or just selected calculators (from a check list).
To send files to multiple calculators
1. Select the Select Calculators button on the dialog box.
2. Check the boxes to next to the calculators you want to select.
3. Click Send.

Dragging and Dropping Screen Captures to Computer Applications

Using the Screen Capture workspace, you can drag and drop captured screens into
many computer applications. This feature lets you use calculator screens in your
documents.

To drag and drop screens into computer applications
1. Open or capture the screen.

2. Drag and drop the screen to an open document or presentation computer software
application.

Note: You may also use Edit>Copy>Paste into an open document or presenter computer
software application.

10 Using the Screen Capture Workspace



Using the Calculator Explorer Workspace

Calculator Explorer workspace allows you to manage calculator content.

TI Connect™ CE

File

Edit View

CONNECTED CALCULATORS (1)

% TI-84 Plus CE - ADAD

TI-84 Plus CE
NAME

@ sciools

@ Probsim

@ Plysmiz

@ cabrir

[T celSheet

@ Eeasypata

o INNODISC

g QUADTHEO

oo THEKICK

) s

+}

L5

SR

()

L

02y

012 v

Archive: 1,807 kB available

e
Flash Application
Flash Application
Flash Application
Flash Application
Flash Application
Flash Application
Program

Program
Protected Program
Real List

Real List

Real List

Real List

Real List

Real List

Real Number

Besl Mumhar

RAM: 140 kB available

T sze
54kB
71kB
s8ks
102 kB
123 kB
167 kB
9478
2kB
ke
28
28
28
28

28

9B

an

LocATION
Archive
Archive
Archive
Archive
Archive
Archive
RAM

Archive

Using the Calculator Explorer Workspace
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Parts of the Calculator Explorer Main Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View tions Help

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to add, transfer, or delete files from your calculator.

&
OO 0 6

Add content from your computer.

Send selected content to your computer.

Send selected content to another connected calculator.

Delete the selected file.

Refresh the view of a connected calculator's contents.

or i~ ol = =Y |7

Content Panel - Select files you want to manage from this panel.

& 11 Connect™ CE o[
Fle Edt  View  Acions  Help
p=i @

(G CONNECTED CALCULATORS () TI84PlusCE  Archive: 1807 kB avalable | RAM: 140 k8 available

B @ o A o + s Location
@ scmools Flash Application saks Archive

. (@ ProbSim  Flash Applcation 7ke Archive
@ eysmie Flash Application aske Archive
@ cabrir Flash Application 10248 Archive
(@ celsheet  Flash Applcation 123k8 Archive
@ Easydata  Flash Application 167k8 Archive
&b INNODISC  Program 078 RAM
&b QUADTHEO  Program 218 Archive
S THEKICK Protected Program ke RAM
L Real List 28 RAM
£ L Real List 28 RAM
1 L Real List 28 RAM
1 e Real List 28 RAM
u Real List 28 RAM
£ Real List 28 RAM
oz v Real Number o8 RAM
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Selecting a Connected Calculator

The Tl Connect™ CE software allows you to simultaneously connect multiple
calculators. Click on the calculator you want to work with to select it. The selected
calculator becomes the default calculator for all TI Connect™ CE software actions.

Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

Copying Calculator Files to the Computer

You can copy most data, files, and programs from your calculator to your computer as
a content backup, to send to others, or to free up calculator memory.

To copy a file from the calculator to the computer

1. Click on the file name to select it.

2. Drag and drop the file into a folder on your computer or onto your desktop.
To copy a file from the calculator to the computer as a content backup

1. Select Edit

2. Select All

3. Drag and drop the file into a folder on your computer or onto your desktop.

Note: There is no auto backup feature here.

Warning: Do not disconnect the cable during a transfer.

To copy a file from the computer to the calculator
1. Navigate to the desired file on your computer.
2. Drag the file to the Calculator List Panel and hover over the desired calculator.
3. Release the mouse button when you see * Copy
4

Select a file name from the drop-down menu. This will be the name of the file on
your calculator.

5. Click Send.
Sending Files to Connected Calculators

You can send files to calculators connected to Tl Connect™ CE software.

|Warning: Do not disconnect the cable during a transfer.

To send files to connected calculators
1. Click the file(s) in the Content Panel to select it.

b
2. Click .

Using the Calculator Explorer Workspace 13



& send to calculators x|

DESTINATION CALCULATORS:

() All Connected Calculators (®) select Calculators

[/] TI-84 Plus CE-1027

[/] Ti-84 Plus CE-1B5E

|:| Replace existing content with the same name on destination calculators

CANCEL SEND

e DESTINATION CALCULATORS: Select whether you want to send the file to all
connected calculators, or just selected calculators (from a check list).

To send files to select calculators

1. Select the Select Calculators button on the dialog box.

2. Check the boxes next to the calculators you want to select.
3. Click Send.

Converting and Sending Background Images

The TI-84 Plus CE can display background images and Pic Vars. These variables display
in the graph area.

Note: All information on background images also applies to the TI-84 Plus C Silver
Edition and the TI-83 Premium CE.

Working with Background Images

The Tl Connect™ CE software automatically converts any image you send to a
connected calculator into a Background Image Var. Your image may display differently
in the graph area than you expect given the conversion to the pixel dimensions of 83 x
133.

14  Using the Calculator Explorer Workspace



Note: For best results, please edit your image to be proportional to 83 x 133 pixels
prior to the conversion to 83 x 133 pixels.

Tip! Try to convert your image as described below. If the conversion is not as you
expect, scale your picture similar to the graph area where Background Image Vars
are displaying on the CE.

Take a screen capture of the graph screen at 100% scale using Screen Capture
Workspace. This screen capture can be either in Full or Graph-Table mode. You
will use this to scale your image to a smaller size to fit the size of the graph
area.

Use a favorite presentation software and display both the screen capture and
your picture.

Drag (size) your picture to a smaller size and to the proportion of the graph
area.

Use a snipping tool to snip the new smaller image. Save that image to your
computer.

Use this smaller, proportional picture to convert to an Image Var following the
next steps below.

Reminder! Preserve your original picture file by using a different computer file
name of your smaller picture.

The conversion to the Background Image Var uses 16-bit color.

You can also upload a Background Image Var into the TI-84 Plus CE emulator view in
TI-SmartView™ CE software.

On the TI-84 Plus CE, a Background Image Var displays as the background in the graph
area only. A background image will display scaled for the MODE screen settings of Full,
Horizontal, and Graph-Table. This preserves any mathematical modeling done on a
background. You cannot edit a background image while working on the TI-84 Plus CE.
Background images run from and are stored in Archive memory.

Using the Calculator Explorer Workspace 15



Sending a Background Image to a Connected Calculator
You can send a background image and display it in the graph area of the TI-84 Plus CE.

Note: All information on background images also applies to the TI-84 Plus CE-T, TI-84
Plus C Silver Edition, and the TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN HP l]

Open the Tl Connect™ CE software.

Choose the Calculator Explorer workspace.

Connect the TI-84 Plus CE to the computer using the cable.
Turn on the TI-84 Plus CE.

Choose the image you want to convert.

Drag the picture to the Calculator List Panel and hover over the desired calculator.

Release the mouse button when you see * Copy |

® N O Uk W DNPR

Select an Image#t name from the drop-down menu (Image0 - Image9). This will be
the name of the image on the TI-84 Plus CE.

Note: The Image# name you choose becomes the image name on your calculator.
Note this Image# name (or make it part of the file name on your computer) for
identification when you want to send or share this file.

WARNING: Pre-loaded images are stored in Imagel - Image5. Use other Image# to
avoid overwriting the pre-loaded images.

9. Click Send.

Note: Rename the computer file so you can identify your Image Var later (bridge,
fountain, etc.) The Image# internal calculator var name will not be changed.

Note: To save the background image to your computer, drag the Image# from the
Calculator Explorer to your desktop or to the folder where you want to save it.

e Todisplay your new background image in the graph area of the TI-84 Plus CE, press
(2nd] [format] change the Background setting to the Image# you just sent to the
calculator (example: Image5), and press [graph).

Note: From the graph screen on the calculator, you can also change the Background
using [draw]; BACKGROUND; 1:BackgroundOn interactive command.

16 Using the Calculator Explorer Workspace



Data Import

The Data Import feature lets you convert/send spreadsheet data saved as csv data files
to the calculator as calculator list(s) or matrix file.

Access the Data Import feature from Calculator Explorer Workspace.
Highlights:
e Create (or download) a spreadsheet of data.

e  Prior to import, edit data in your spreadsheet software to only allowed calculator
numeric formats (specified below) for the import to a calculator file.

About the spreadsheet

e Only one spreadsheet saved as a CSV (Comma Delimited) (*.csv) file will be
imported via Calculator Explorer workspace at a time.

e Spreadsheet (csv) file can be dragged into Calculator Explorer or imported via
Actions > Import Data (.csv) to List/Matrx... menu.

e Upto 6 calculator lists or 1 matrix from the spreadsheet data will send to the
connected calculator.

Rules for preparing the spreadsheet for import:

e All cells must contain Real Number data as experienced on the calculator and no
text.

- Complex numbers are not supported for data import.
e Data must startin cell Al
e List(s) Import: If calculator lists are desired:

|

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell AL, contains only Real numeric values, and does
not contain text,

Select calculator file type for conversion:

FILENAME: temp_data.csv

COLUMNS:

{-} Lists v 1 v

CANCEL CONTINUE

- Only six spreadsheet columns A-F will be imported

- Columns can be of length up to 999 cells.

- The first empty cell in a column will be interpreted as the end of the data for
that list import

e Matrix Import: if calculator matrix is desired:

Using the Calculator Explorer Workspace 17



|

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell AL, contains only Real numeric values, and does
not contain text,

Select calculator file type for conversion:

FILENAME: temp_data.csv

ROW:  COL: CELLS:

L] matrix v 2 x| 2 4

CANCEL CONTINUE

- Only one matrix can be imported from a spreadsheet file.

- Upto 400 cells can be imported. (Example: row x col: 10 x 5 = 50 cells from
row range 1-10, columns A-E.)

- Dimension of matrix of the form (row x column) will be requested during the
import experience in Calculator Explorer.

- Any empty cell within the specified matrix dimension will be interpreted as 0.

¢ Do not have data in the spreadsheet outside of the allowed sizes for list(s) or
matrix as described above. Otherwise, the file will be invalid when a data import
to Calculator Explorer is attempted.

To save calculator list(s) or matrix files

e To save calculator files created to the computer, after import/send to calculator,
drag the list(s) or matrix file from Calculator Explorer to the desired computer
location.

Deleting Calculator Files
You can delete data, files, and programs from your calculator.

To delete files from the calculator

1. Click on the file in the Content Panel you want to delete.

2. Press .

Quit Exam Mode Setting on Connected CE Calculators

Quit the exam mode setting on your CE by connecting CE calculator(s) to the computer
and selecting

e Actions > Quit Exam Mode on Connected CE Calculators in Tl Connect™ CE.

Reminder: Use the latest CE Bundle at education.ti.com/84ceupdate to ensure your CE
has the latest and appropriate calculator files for your TI-84 Plus CE.
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Using the Program Editor Workspace

The Program Editor Workspace allows you to work with Tl Basic programs.

-[0] x|

New Program

_|_

Open Program

-
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Parts

of the TI-Basic Program Editor Workspace

e _ ol x|

File  Edit  View

+

=
L

9 New Program

_|_

Open Program

o

Menu Bar - Use these menus to manage files and programs, and to get help.

File Edit View  Acti

Note: In the Program Editor Workspace, you can only drag and drop
programs to the Content Panel.

Toolbar - Click these icons to Create new program, Open program, Save
program to computer, Send program to connected calculator(s), Undo, or Redo
and Font Size Slider.

+ @8 @ © o e A

o8 6 o e (6]

Create new program.

Open program.

Save program to computer.

Send program to connected calculator(s).

Undo or Redo.

QO e
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® Font Size Slider to increase or decrease the size of text in:
e Catalog Panel
e Program Editor

(3]

Content Panel - Use this panel to create, view, and edit programs.

New Program

_|_

Open Program

-

Catalog Panel - Use this panel to select your calculator type and then choose
from the catalog tree list (by category) to create programs.

* Angle

» Catalog

* Char

* Distribution
* Draw

* Finance

* Format
»List

* Math

* Matrix

* Memory

* Mode

* Program

» Statistics
» Stat Plots
» Table Setup
* Test

* Variables

» Zoom

Using the Program Editor Workspace
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@ Syntax Reference Panel - Use this panel to view the proper syntax of each
command along with required and optional arguments.

x Reference

AsnConp (prgmASM1, pragn/

Creating a New Program

When no programs are open, the Content Panel displays only the New Program and
Open Program icons.

To create a new program New Program

» Click the New Program icon. _|_

To open an existing program

Open Program

1. Click the Open Program icon. —

2. Navigate to the appropriate folder. -
3. Click Open.

Editing a Var Name

New program names are PROG##. The numbers run in sequence, ex: PROGO01,
PROGO2.

To change the program name

> Click inside the Var Name box and type in a new name up to 8 letters or numbers
(first cannot be a number.)

VAR NAME:  PROGO1

Protecting Your Program

Tl Connect™ CE software allows you to protect your program from being edited after
the program is sent to a connected calculator.

To protect your program

> Click the check box next to the lock icon. H
Saving a Program to Your Computer

The asterisk at the beginning of a program name indicates that the program is not
saved.

22 Using the Program Editor Workspace



To save a program

1. CIick.

2. Navigate to the appropriate folder.

3. Click Save.
Closing a Program
To close a program

> Click the x by the program name.

Using the Program Editor Workspace
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Using the Catalog Panel

The Catalog Panel contains a list of calculator commands, functions, variables, and
symbols you can use to create programs.

To expand or collapse a Catalog level

» Click the triangle beside each Catalog entry.

TI-84 Plus CE e *Untitled1.8xp X

» Keypad

» Angle VAR NAME: | PROGO7
» Catalog

» Char

Distribution
Draw

>
»>
» Finance
>
>

Format
List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
MEARD
rnfd4rUnid
» Matrix
» Memory
» Mode
» Program

» Statistics
» Stat Plots
» Table Setup
» Test

» Variables

» Zoom

Reference

No reference available

To place a Catalog entry in the Content Panel

> Drag and drop the Catalog entry into the Content Panel. This places the cursor in
the program editor command line after the item is dropped.

-OR-
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» Double-click the Catalog entry. This pastes the item to the program editor and the
focus remains in the Catalog Panel to select another item. Click back at the end of

the command line to continue typing in the editor.

To avoid Syntax errors

Use the catalog of commands and symbols to paste to the editor to avoid syntax errors
due to the incorrect use of upper and lower case in commands.

Example:
Did you type Eval( or eval(?

Did you type sin( or Sin(?

The catalog
tree list pastes | TI-84 Plus CE ~ *Untitled1.Bxp X
the correct
case and DispGraph

Space DispTable VAR NAME:

formatting. »DMS
Dot-Thick
Dot-Thin
DrawF

l 281 eval{

Drawlnv
DS<(

e

=

E

MEFF(
El=s
End

Eng
EqurString(
eval (
ExecLib
expr(
ExpReg
Exproff
Expron
Fcdf (

% Reference

Brtimme n ctrdinn

PROGO1

Extra Space Syntax Errors

Running a Program on a Calculator

Extra spaces can cause a Syntax error when a program is runs on the calculator.

Using the Program Editor Workspace 25



Where are the extra spaces?

You can see extra spaces in your
program using Tl Connect™ CE Program
Editor by selecting the entire program.
Extra spaces at the end of command
lines should be deleted prior to sending
the program to the calculator.

VARNAME: SNAKE

| )
A+26 ( (A=) - ( -2fn*
1@ 1

When the program runs in the calculator, if there are extra spaces, selecting Goto from
the syntax error screen will place the cursor on the program line where the error
occurred. Check the line for correct syntax and extra spaces at the end of the command
line.

VARNAME:  SNAKE

URMAL FLOAT AUTA REAL RADIAN MP n
([PROGRAM LINE 11

ERROR: SYNTAX

ClrHome

1:Quit

13-A
548
124X
1+P
3440

: Xedin(L1)
:X+dim(L1) Xadin (L2)
:X>dim(L2) i L”

(F111(B,L1)

PTG LaP). )
*Repeat KE45S theputted 1o

/] BaL1 (P)
5 AsLz(P)
/ P+1-X(P=X)~P
& tKey-K
Cursor lands on error. 3 o (ke(24,25,26,34})
K+D

A+ (D=26)- (D=24) +A
B+(D=34)- (D=25)-B
A+26( (A=B) - (A=27) )-A
B+1@((B=0)-(B=11))+B
End

e Move cursor to the end of that command line.

e Carefully delete extra spaces.

Note: There is no undo on the calculator.
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WORFAL FLOAT AUTO REAL EADIAN HF n HORRAL FLOAT AUTO KEAL RABIAN riF n

PROGRAM : SNAKE

:ClrHome :ClrHome
:12+A :13+A
15+B 1548
1104X P10
1P 1P Spaces
1340 134D
) | Xsdim(Lall i¥edimils)  H
iXrdimilz) s rdimilz}
tFil11(B.L1} tF11liB.L1)

When Do Commands Become Calculator Commands (Tokens)?

The commands do not become calculator commands (tokens) until the program is sent
to the calculator.

If there is an error when your program sends to the calculator or runs on the calculator,
check to see if every command in the calculator program edit mode is actually a
command token.

How Do You Know?

When a command is a token on the calculator, the cursor will be on the first character
and then jump over the command as a token. If the cursor moves letter-by-letter
through a command, that command did not get converted. Delete and paste the
command from the calculator.

. PROGRAM: B PROGRAM: B On the calculator, the cursor
) :EnvBinom( :invBinom(H

jumps over the “token.”

It only understands the
characters as a function or

command name.

Reminder: When entering a program directly on the calculator, the command or
function pastes completely as a token.

Warning: Some calculator commands such as LEFT, CENTER, RIGHT, FRAC, are words
you might use in a string. If a word you use in a string is the same as a calculator
command, your word will become a calculator token and may give errors in your
program. Avoid using words or parts of words that are the same as a Tl-Basic
command to avoid unintentional tokenization to a command.

Warning: The language setting of Tl Connect™ CE determines how the text is
interpreted as a command token for the calculator. Opening programs and sending
back to the calculator with Tl Connect™ CE in different languages may result in:

e undesired command tokens and/or

® syntax errors
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Using the Syntax Reference Panel

The Syntax Reference Panel displays the syntax of each Catalog entry, including
required and optional arguments.

HUB menu for TiI-Innovator™ and TI-Innovator™ Rover

Program Editor supports the Tl-Innovator™ HUB menu for Tl-Innovator™ and TI-
Innovator™ Rover commands. The HUB menu is located in the Program menu in the
catalog tree. This HUB menu addition to the Tl Connect™ CE Program Editor is the
same HUB menu experience as when the Hub App is loaded on the CE calculator.
Please always use the latest versions of the CE OS and CE Hub App.

Note: Update your CE with TI83CE Bundle v5.4.0 at education.ti.com/84ceupdate.
The update contains Hub App v5.4.0. TI Connect™ CE v.4.0 Program Editor does not
contain the Hub App v5.4.0 update at this time. Some entries in Hub App v5.4.0 may
not appear in the Tl Connect™ CE v5.4.0 menus but can be typed in for use.

See Also:
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Using the Catalog Panel ¥ Program

Sending a Program to a » Contro
Calculator » Input/Output
» Colar
* HUB
» Sond["SET

» Send| "READ
» Settings

Wait

eval
® fover (EV)...
®» Sond(| "CONNECT-Output
» Send[ "CONNECT- Input

* Ports

¥ Send| "RANGE

¥ Send( "AVERAGE

¢ Send| "DISCOMNECT -Output

¢ Send | "DISCONNECT - Input

*» Hanage

Sending a Program to a Calculator
You can send a program to a connected calculator.

To send a program to a connected calculator

1. If you have not already done so, save the program.

a3
2. CIick.

* FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the program on your computer.

e NAME ON CALCULATOR: select the program name (it should be the default, but you
may change the program name by clicking Custom).
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8 Send to Calculators N [=T |
FILE NAME: NAME Ol CALCULATOR: Location:
Utitled1 81 FRoGOL i Ram
Qustom

DESTINATION CALCULATORS:

Al Connected Calculators ® Select Calculators

M T1-84 Plus CE-ADAD

CANCEL  SEND

== Name on Calculator

Custom Program names can be up to & characters in length
The first character can be A-Z or 8.
The remaining characters can be A-Z, 6 or 0-9

CANCEL

LOCATION: Choose whether you save the program in the calculator's RAM or

Archive.
DESTINATION CALCULATORS: Select whether you want to send the program to all

connected calculators, or just selected calculators (from a check list).

To send programs to multiple calculators

1. Select the Select Calculators button on the dialog box.

2. Check the boxes to next to the calculators you want to select.

3.

Click Send.

Language Settings

If you wish to develop a TI-Basic program in a language different than your computer

0OS language setting, you can re-launch Tl Connect™ CE in another language.

1.
2.

Select File > Change Language.

Select the language change after restart of the application.

=2 Choose a language

=1 x|

English (US) ™

QUIT LATER QUIT NOW

Language changes will take effect after application restart.

CANCEL

QUIT LATER - Retains the language selected and Tl Connect™ CE will launch in this

selected language the next time Tl Connect™ CE is launched.

QUIT NOW - Closes the software app. Tl Connect™ CE will launch in this selected

language the next time Tl Connect™ CE is launched.

CANCEL - No language change. Computer OS language will be the default.
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Maintaining Your Calculator
Updating the Calculator Operating System

Tl Connect™ CE software lets you download operating systems for graphing calculators.
Before you begin

e Backup your calculator files (RAM, Archive, and Apps).

e Make sure your calculator is turned on and securely connected to the computer.

¢ If you have multiple calculators connected with USB computer cables, OS transfers
can occur to specific calculators.

This can be done by selecting the specific calculators in the Send dialog.

Warning: Do not disconnect the cable during a transfer.

To update graphing calculator operating systems
1. Click Actions > Send OS.

2. Navigate to the correct OS file for your model of calculator stored on your
computer.

3. Click Open..

The Send OS dialog box opens.

|

4. Select from Destination Calculators:
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DESTINATION CALCULATORS:

All Connected Calculators ®) Select Calculators

o TI-84 Plus CE-12A2

5. Press Send e

Tl CE Bundle file — use one computer file to update your CE
calculator!
Update your connected CE calculator(s) in one step using Tl Connect™ CE and the new

TI CE Bundle downloaded from education.ti.com/84ceupdate. Always download the
latest Tl CE Bundle at education.ti.com/84ceupdate.

Connect your CE calculator(s) to Tl Connect™ CE. Drag the appropriate Tl CE Bundle to
Calculator Explorer.

e TI-84 Plus CE/CE-T: TIS4CEBundle-x.x.x.xxxx.b84

Tl Connect™ CE will update your CE OS, any CE Apps that need to be updated or are
missing from your calculator(s) and also load the 5 pre-loaded Image Vars to Imagel —
Image5. The process cannot be stopped so make sure to save off (drag off) any of your
favorite calculator files using TI Connect™ CE Calculator Explorer. You can drag your
favorite calculator files back to your calculator after the new TI CE Bundle process
completes.

Drag the CE Bundle to Calculator Explorer. Please wait until the complete process
finishes. Do not pull the cable during any file transfer. Expect the CE calculator to
reboot prior to the Image Var and Apps transfer. Expect the CE calculator to
defragment (rearrange memory) at some time during the process. Messages display
when transfers take place on the TI Connect™ CE window.

Note: Do not confuse the TI CE Bundle file with the CE OS and CE Apps file still
available to download separately on education.ti.com. The Tl CE Bundle contains all the
latest files you need to update or restore your CE calculator(s) as though you just
bought your calculator and provides a fast way to update your class set

CE calculator(s).

Important: If the CE calculator screen says "Waiting..." the calculator has lost the OS.
This can happen if a cable is pulled from the calculator or computer during a file
transfer. If connected, disconnect and reconnect the CE to the computer. Drag the CE
Bundle to Calculator Explorer.

Reminder: Wait until the complete process finishes. Do not pull the cable during any
file transfer. Expect the CE calculator to reboot prior to the Image Var and Apps
transfer. Expect the CE calculator to defragment (rearrange memory) at some time
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during the process. Messages display when transfers take place on the Tl Connect™ CE
window.

You may repeat this process and the CE Bundle will transfer the files again. Do not pull
the cable during any file transfer.

See Also:
Updating the Calculator Operating System

Sending Files to Connected Calculators
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Getting Calculator Information

Tl Connect™ CE software allows you to get information about your calculator's type,
product ID, OS Version, RAM, Archive, Language, ROM Version, and Hardware Version.

Note: Calculator Information is available only from the Calculator Explorer
Workspace.

To view calculator information

» Click View > Calculator Information.

+4 Calculator Information X

ca
f
=]
(=
(]
(]

Calculator:
Product ID:

_____ 0S5 Version:
RAM:

Archive:

Language:
ROM Version:

Hardware Version:

CLOSE

Compatibility with Graphing Calculators

Please refer to the TI-84 Plus CE Getting Started Guide for compatibility with graphing
calculators.

Apps, Operating Systems and some data files with unsupported numeric types do not
share between models.

TI-Basic programs may need to be modified to correctly display on the higher
resolution color screen models.
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General Information
Online Help

education.ti.com/eguide

Select your country for more product information.

Contact Tl Support

education.ti.com/ti-cares

Select your country for technical and other support resources.
Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.
Updates

education.ti.com/84ceupdate
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